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NCSA Mosaic is an Internet navigation and data retrieval tool.    It makes access to network 
information as easy as clicking a mouse button.    Mosaic is capable of accessing data from World
Wide Web servers (HTTP), Gopher servers, FTP servers and Usenet News servers (NNTP).    
Mosaic can also access other data sources and services through gateway servers.    These services
provide search capabilities in database environments such as PH, Archie, WAIS, and Veronica.    
NCSA Mosaic provides transparent access to these information types.    NCSA Mosaic software 
is copyright by The Board of Trustees of the University of Illinois (UI), and ownership remains 
with the UI. The UI grants you a license without a fee to use the Mosaic software for personal, 
academic, research, United States government and internal business purposes.    Mosaic is 
designed to operate under the following Microsoft Windows environments.

Windows 3.1x, Windows for Workgroups 3.1x, Windows 95, Windows NT 3.5x

Mosaic Help is also right mouse button sensitive under Windows 95 and Windows NT 3.51.    
Click the right mouse button to access the following options:

Annotate... Annotate a help topic for future reference.
Copy Copy the selected text to the clipboard.
Print Topic... Print the current Help page.



Font Small, Normal, Large
Keep Help on Top Default, On Top, Not on Top 
Use System Colors Help matches images colors to your system

Use this Help file by clicking on the Mosaic window above or select one of the topics below.    

Glossary of Terms
Mosaic Command Line Options



File Menu Commands
Click on the image for help.



Open Document...
Opens a dialog box where you enter the address of a document.    Presently the 
addresses are in the form of a URL: 

(protocol://machine.name/directory/path/filename.html) 

 Select the green check to load the document or the red X to abort the request.



Open Local File...

Opens a dialog box that allows you to browse on your local system. Select the desired HTML or 
ASCII file and select OK to load the document.



Save As...

Opens a standard Windows Save As dialog box that lets you save the current document in its 
original format (i.e., HTML or ASCII).



Save As Text

Opens the Save As Text dialog box that lets you save the current document in ASCII format, 
omitting the in-line images and table information that may be included in the document.



Print...

Opens a Print dialog box, that displays the status of your current printer and the print range.    
Select OK to print the current document.



Print Preview

Mosaic displays the current document in a preview format.    Within print preview there are 
several functions that allow you to view the present document as it will appear on the printer.    
Select Print... to print the document, or Close to close print preview.



Print Setup...

Opens a dialog box that allows you to configure the define or configure the settings of the 
printer.



Newsgroups...

Displays the list of subscribed newsgroups in the Mosaic document view Window.    The 
document view window also displays an additional news toolbar interface.



News Interface Toolbar 

This tool bar is present while you are viewing News.    The toolbar moveable and can be docked 
on any side of the Mosaic window or anywhere outside the Mosaic window.



    Move to previous news article.



    Move to next article in list.



    Move to previous topic in newsgroup.



    Move to next topic in newsgroup.



    Post article to newsgroup.



    Follow -up reply to a article in newsgroup. (Public post)



    Reply to the author of a newsgroup article.    (Private reply)



    Return to newsgroup article list.



    Find article in current newsgroup article list.



    Find next article in list.



 Catch Up all articles in current newsgroup.    (Marks all articles as have been read.)



    Move to next newsgroup.



    Move to previous newsgroup.



    Return to the list of all subscribed newsgroups.



    Open the newsgroup subscriptions window.



Send Email...

Opens the Mail... dialog box. Enter the address of the recipient , the subject, and content of the 
mail message.    You can include the URL of the current document, the text of the current 
document, include a file using the Import File feature and append a signature file to the end of 
the mail message with a click of the button. Select    Send    and Mosaic sends the mail message 
to the mail server defined in your Preferences, Services menu.    The mail server then delivers the
mail message to the recipient.    Select Abort to cancel the email message.



Document Source...

Opens the Document Source window, which displays the source file of the current document. 
Most are in HTML format, but some files are ASCII.    The document source window has two 
menus (File and Edit). The File menu, has a Save function that allows you to save the source file.
The Edit menu, has a Copy function that allows you to copy information from the file to the 
Windows Clipboard.



Exit
Closes the window and exits NCSA Mosaic.



Collaborate...
Click on the image for help.

Collaborate offers you more than a simple talk or chat session between Mosaic clients. 
Collaborate allows you to link your Mosaic session with other Mosaic users, send 
files, and exchange data with other collaborators.    Collaborate works on the client-
server principle and each Mosaic client contains a collaborative client and server. The 
collaborative client allows you to connect to a collaborative server and communicate 
with other Mosaic users.    The collaborative server initiates a collaborative session 
and relays all data between the clients.    

Joining a Collaborative Session:
1. Enter the name or IP number of the machine that is hosting the collaborative session.
2. Enter the port number of the collaborative session.    (Note: The port number is provided by 

the host of the collaborative session.)
3. Click    Join a Session.

Hosting a Collaborative Session:
1. Enter the name or IP number of your machine.

2. Select a port number.    (1 - 9999)
3. Click Host a Session (but do not join)    or    Host a Session (and join) depending on 
your preference.

After you setup the collaborative environment, Mosaic opens a Collaborative Session Window.    
This window is your interface to the collaborative session.    

NOTE:    There are a number of ways to limit these collaborative features using the special 
command line options 



Your IP Address:

The Internet Protocol (IP) number of your system.



Host Name:

Enter the name of the machine that will host the collaborative session.    For example, 
collab.ncsa.uiuc.edu.



TCP/IP Port:

Enter the port number where the server will send and receive messages. The port number is 
arbitrarily defined by the Mosaic user who initiates a collaborative session and must be less than 
9,999. 



Join a Session

Initiates a collaborative client.    Select this option and fill in the appropriate Host Name: and port
number to join a session. 



Host a Session (but do not join)

Initiates a collaborative server with out initiating a client.    This option is practical for users who 
would loan their machine as a host of a collaborative session yet they do not want to participate 
in the session.

NOTE: You can join a session after youve selected this option.    Simply select Join a Session and
enter your machines name, the define port number and click Start to join the session.



Host a Session (and join)

Initiates a collaborative session and a client.    Select a port number between 1 - 9,999 and select 
Start to begin a collaborative session.



Start

Select Start to begin and/or join a collaborative session.



Stop Host

Terminates a collaborative server.



Cancel

Cancels the entries in the collaboration setup window and returns you to the main Mosaic 
window.    



Collaborative Session Window
Click on the image for help.

The Collaborative Session Window contains three working areas:    the message display area, the 
collaborator list and the message edit area.    The window also contains a toolbar that gives you 
easy access to some of the menu functions.    The collaborate window is also sensitive to 
Windows drag and drop feature.    You can drag and drop a file from the File Manager, Windows 
Explorer or the desktop to the Collaborative Session and it to the members of the current session.



Message Display Area

This area displays all messages being written during a collaborative session.    The name of the 
message sender will appear in front of the displayed message. 

e.g., mosaic-w> Hello World



Collaborator List

A list of the current members in the collaborative session.    Double click on a name to identify 
the chat alias, user name, email address and IP number.    The names in the collaborator list is 
defined by the Chat alias field in the Services preference.    If a chat alias is not defined, Mosaic 
will use the user ID on your email address.



Message Edit Area

Type your message in this section of the window.    The Message Edit Area accepts paste 
commands(Ctrl+V) from the clipboard and supports word wrap so your message will 
automatically advance to the next line.    Submit your message to the collaborative session by 
clicking on the Send button or hit the Return/Enter key on the keyboard.



Collaborative Window

This area as the entire collaborative session window is sensitive to Windows drag and drop 
feature.    That is you can send any file to other members of the collaborative session by dragging
and dropping it into the collaborative session window.



Collaborative Session
File Menu 

Click on the image for help.



Save Session Ctrl + S
Saves the current session to a file. By default the file is named collab.txt and it can 
be found in the default download directory as defined in the Directories preference 
sheet.    This function is also available from the toolbar by clicking the .button.



Clear Message Box Ctrl + N
Clears the contents of the Message display area.    This function is also available 
from the tool bar by clicking the  button.



Exit
Terminates the client and closes the collaborative session window.



Collaborative Session 
Options Menu 

Click on the image for help.



Send Links Ctrl + L
This function links multiple Mosaic sessions by sending the URL of the current 
page to the other members of the collaborative session.    A check appears next to 
the menu item when this function is enabled.    The  button in the toolbar is 

another way of switching the feature on and off.



Follow Links Ctrl + F
The Send Links and Follow Links functions allow multiple Mosaic sessions 
to act as one session.    Everyone sees the same data in their respective Mosaic 
window.    An arrow appears next to the menu item when the function is active.    
Follow links can also be switched on and off by clicking the     button in the 

toolbar.    



Audio Notification Ctrl + A
When active, the system will make an audio notification when a new message has 
arrived in the message display area.    An arrow appears before the menu item when 
the feature is active.    The audio notification feature can also be switched on/off by 
clicking the  button in the toolbar.



Refresh User List Ctrl + R
Queries the collaborative server for a current list of members.    This function is 
available from the toolbar by clicking on the  button.



Always on Top
When checked, the collaborative session window is always on top.



Save Settings on Exit
Saves all your user configurable settings when you exit a collaborative session.



Save Settings Now
Saves the current settings immediately.



Collaborative Session Toolbar
All functions and icons are defined in the menus.    Please refer to the menus items
for more information. 



Edit Menu Commands
Click on the image for help.



Copy Ctrl +C

Copies selected text to the clipboard.    The text can be selected from the Mosaic document 
display area, the location bar, the document source window, and the text-entry fields in various 
interactive windows (e.g., the File, Open Document... window ).    You can also use the shortcut 
keys Ctrl+C, hold the control key and hit C.    Copy is also available from the right mouse button 
menu. Click the right mouse button and select Copy from the menu.

NOTE:    Mosaic also recognizes Ctrl + Insert as a Copy command.



Paste Ctrl+V

Pastes the selected text to the current position of the cursor.    Text can be pasted into the location 
bar , the text-entry fields in various interactive windows (e.g., File, Open Document...) , and into 
forms within the document view window.    Paste also has a shortcut key, hold the control key 
(Ctrl) and hit V to paste selected text to the current position of the cursor.

NOTE:    Mosaic also recognizes Shift + Insert as a Paste command.



Find... Alt+F3

Opens the Find dialog box. Enter the characters, word(s), or phrase you want to search for in the 
current document.    Click Find Next to begin search.    If you want your search to be case 
sensitive, make certain the Match Case box is checked.    Find also has a shortcut key, hold the 
Alt key down and hit F3 to open the Find dialog box.



Find Next F3

Initiates a search with the current entry in the Find dialog box.    Find Next also has a shortcut 
key, hit F3 to find the next instance of the current character string.



Select All
Selects all the text in the Document View Window.    Select copy from the Edit
menu or from the tool bar to copy all text to the clipboard.



Options Menu Commands
Click on the image for help.

The first four entries on the Options menu are toggles.    If a check mark appears before the item, 
it is active when you start a Mosaic session.



Show Toolbar

When checked, the Toolbar is active and appears below the menu bar.    The toolbar offers easy 
access to several functions:    Save to Disk, Save to Disk, Print, Print Preview, Back, Forward, 
Reload, Load Home Page, Find, Save to Hotlist, Read Newsgroups, Send Internet Mail, and 
About.



Show Status Bar

When Show Status Bar is active, the status bar is displayed at the bottom of the Mosaic window.  
The status bar contains three areas, Text status, Graphic status, and a Download indicator.    
Select the status bar on the main page for more information.



Show Location Bar

When checked, the Location Bar is displayed under the Toolbar if it is active or under the Menu 
bar if the Toolbar is not active.    The location bar has a few functions:    The X allows you to 
cancel an entry in the location field and it returns the field to the original document address.    
Selecting the Check submits the current address and prompts Mosaic to load the document.    The
location field displays the address of the current document.    The location field also allows you 
to enter an address to a document in the form of a URL.    The arrow button opens a list box that 
contains a list of the document addresses visited during the current Mosaic session.



Presentation Mode

Expands the document view field to a full screen view.    By default the title bar, menu bar, tool 
bar, location bar, and status bar are turned off.    You can toggle the tool bar, Location bar and 
status bar on and off using Alt + T, Alt +L, and Alt +S respectively.    Alt-P toggles the 
presentation mode on and off.



Navigate Menu Commands
Click on the image for help.



Back B

Moves back one document in the history list. Back is mapped the  button in the toolbar and to
B or b on the keyboard.    Select back from the menu, click on the button in the toolbar or hit B or
b to move back in history.    Back is dimmed or grayed out when there is no previous document.   



Forward F

Moves forward one document in the history list. Forward is mapped to the  button on the 
toolbar and the F or f key on the keyboard.    Select forward from the menu, click button on the 
toolbar or hit the F or f to move forward in history.    History is dimmed or grayed out when the 
current document is the last one in the history list.



Reload R

Reloads the current document and all images associated with the document.    Reload is also 
mapped to the  button in the toolbar and R or r on the keyboard.    Select reload from the 
menu, click the button on the toolbar or hit the R or r key to reload a page.



Home H

Loads the document defined in the Options, Preferences, Document, Home Page field.    Home is
also mapped to the  button in the toolbar and the H or h key on the keyboard.    Select home 
from the menu, click on the toolbar button or hit H or h on the keyboard to load your home page 
in Mosaic.    



Stop Transfer S

Cancels the transfer of the current document.    Stop transfer is also mapped to the  button in 
the toolbar, the Mosaic icon, the Esc key and the S key on the keyboard.    Select stop transfer 
from the menu, click the button in the toolbar or press the appropriate key to cancel a file 
transfer.



Session History

Opens a window that contains a tree history of file addresses (URLs).    The current document is 
highlighted and you can move to any other document in the list by double-clicking on the 
address.



Add Current to Hotlist A

Adds the title and address of the current document to the hotlist that is defined in the Hotlist 
Managers Add to: field.    Add Current to Hotlist is also mapped to the  button in the toolbar.   
Select add current to hotlist from the menu or click on the button in the menu to add the current 
document to your hotlist.



Hotlists
Hotlists are user defined shortcuts to World Wide Web documents.    By default we provide a list 
of documents that we thought would be interesting to the Mosaic user group.    See the 
documentation for Hotlist Manager for more information about configuring the list of document 
titles and addresses.



Help Menu Commands
Click on the image for help.



Contents
Opens the first page of the NCSA Mosaic help pages.    NCSA Mosaic Help is context 

sensitive, just point and click on the item of interest.



Search on Help
Opens a search window relative to Mosaic Help



How To Use Help
Opens the standard Windows Help tutorial.



Online Resources
A local file, resource.htm, that provide a quick reference to some on-line
resources.    The file can be found in the Mosaic directory. 



About Mosaic...
Opens a Document View window displaying the current version information,
copyright statement, and a list of the current developers.



Mail Technical Support...
Opens a Document View window so you can email to the NCSA Mosaic for
Windows technical support staff. You can automatically include your system



 Open Document...
Opens a dialog box where you enter the address of a document.    Presently these 
addresses are in the form of a URL: 

(protocol://machine.name/directory/path/filename.html) 

 Select the green check to load the document or the red X to abort the request.



 Save As
Opens a standard Windows Save As dialog box that lets you save the current
document in its original format (i.e., HTML or ASCII).



 Print
Opens a Print dialog box, that displays the status of your current printer and the
print range.    Select OK to print the current document.



 Print Preview
Mosaic displays the current document in a preview format.    Within print preview
there are several functions that allow you to view the present document as it will
appear on the printer.    Select Print... to print the document, or Close to close
print preview.



 Copy
Copies the selected text to the clipboard.    Text can be selected from the document
view window, document location bar, the document source window, and
text-entry fields in various interactive windows (e.g., the Open Document...
window ).



 Paste
Pastes the selected text to the current cursor position.    Text can be pasted into
the document location bar , text-entry fields in various interactive windows
(e.g., Open Document...) , and into forms within the document view window.



 Back
Moves back one document in the history list. Dimmed when there is no previous
document.



 Forward
Moves forward one document in the history list. Dimmed when the current
document is the last one in the history list.



 Reload
Reloads the current document.



 Home
Loads the document defined in the Document Preference Sheet.,



  Stop Transfer
Stops the present download.



 Find...
Opens the Find dialog box. Enter the letters, word, or phrase you want to
search for in the current document.    Click Find Next to begin search.    Check 
Match Case if you want your search to be case sensitive.



 Add Current to Hotlist
Adds the title and URL of the current document to the hotlist that is defined
in the Hotlist Managers Add to: field.



 Newsgroups
Displays the list of subscribed newsgroups in the Mosaic document view
Window 



 Send Email
Opens the Mail... dialog box. Enter the address of the receiver, the subject, and
content of the mail message. You can include the URL of the current document,
the text of the current document, include a file using the Import File feature and
append a signature file to the end of the mail message with a click of the button.
Select Send and Mosaic send the mail message to the mail server you defined
in your Preferences, Services menu. Select Abort to cancel the email message.



 Help
Opens the Mosaic Help Contents Page. 



 Visual Indicator/Interrupt
The animated Mosaic    logo acts as a visual indicator letting you know when
Mosaic is busy downloading a file and as an download interrupt.    Click on the
Mosaic logo, the   tool button, or press Esc on the keyboard to stop the
transfer of a file.



Location Bar

Enter a document address, (URL),    in the location bar.    The Check prompts 
Mosaic to load the document.      The X cancels the request and returns the field 
to the original document address.    The arrow button opens a list box that contains 
a list of the document addresses that have been visited during the current Mosaic 
session.

Use the following accelerator key to assist your typing:

Ctrl + h http://
Ctrl + f ftp://
Ctrl + g gopher://
Ctrl + n news:
Ctrl + m mailto:



Visual Status Indicators

Indicates an application using OLE is connected to your Mosaic session.

Indicates that Mosaic has not made a connection to an information server.

Indicates Mosaic has made a connection to an information server.

Indicates an HTML document is being pulled from the disk cache and not 
from the associated information server.

 Waiting to read data from a server.

Reading data from a server.

Indicates in-line images need to be downloaded for the current document.
To the right of the image icon appears the number of in-line images associated
with the current document.    This number decreases as the in-line image files are
received and paginated.



 Progress Indicator
The Mosaic progress indicator is a visual aid to help you determine the amount of
bytes received for a file.    This area optionally displays the Day/Date/Time when 
Mosaic is idle.    The time settings are in the Window Preference Sheet.



Message Display Area
Reports messages concerning connectivity to the information server and the status
of a file download while Mosaic is trying to retrieve.    While Mosaic is idle, the 
text status area displays the document address of a link when the mouse pointer
is placed over a hyperlink.



Image Anchor
An inline image that links to other information.    Inline image achors are
denoted by a border that has the same color as the text anchors.    Click on 
the anchor to link to the information.



Text Anchor
A word(s) that link to other information.



Title Bar
The title bar displays both the title of the application and the title of the currently
displayed document.



System Menu
Opens the standard Windows system menu.



Minimize/Maximize
The down arrow minimizes the Mosaic window and the up arrow maximizes the
window to fit the entire screen.



Preference Sheet
Anchors

Click on the image for help.



Miscellaneous

The following options are active when the boxes are checked.

Change Cursor Over Anchor:
The cursor changes from the standard arrow to a hand with a pointing
finger when the cursor is over a hyperlink or anchor.

.
Underlined:

All anchors or hyperlinks are underlined. (This feature is particularly useful
 if you are using a black and white monitor.)

Show URL in Status Bar:
The    URL of an anchor is displayed in the status bar when the cursor
is over the anchor.

Visually Age Visited Anchors
Gradually changes the color of an anchor from the visited or cached color to the
unvisited color as the anchor gets closer to the expiration period specified in the 
next feature.

Expire Visited Anchors:
Length of time before an anchor reverts to the unvisited anchor color.



Current Anchor Highlighting

Using a framed, buttoned, or hatched anchor, the left and right arrow keys are enable for
anchor navigation.    The right arrow will advances you to the next anchor in a document 
and left arrow key returns you to the previous anchor in the document.

Framed:
Surrounds the current anchor with a solid frame.

Button:
Gives the current anchor a 3D button effect.

Hatched:
Surrounds the current anchor with a broken frame.

None:
Anchors are not modified by a frame, button, or hatched effect; anchor navigation
with the left and right arrow keys is disabled.

Red: Green: Blue:
The current RGB color value of the anchor border.

Change...
Opens a dialog box where a new color for the anchor border can be selected from
a color palette.



Unvisited Anchor Color

Red: Green: Blue:
Displays the RGB color value for anchors that you have not visited.

Change...
Opens a color palette where you can select a new color for Unvisited anchors.



Visited Anchor Color

Red: Green: Blue:
Displays the RGB color value for anchors that you have visited.

Change...
Opens a color palette where you can select a new color for Visited anchors.

Clear
Erases the global history list, mosaic.ghi..    This file contains a list of URLs 
that represents every document youve visited on the WWW before the defined 
expiration date. 



Cached Anchor Color

Red: Green: Blue:
Displays the RGB color value for anchors that are cached on your local hard drive.

Change...
Opens a color palette where you can select a new color for the anchors of your
Cached files.

On
Turns on the color scheme.    If On is not selected, the anchors will appears as
Visited anchors.



Preference Sheet
Audio

Click on the image for help.



Mosaic Audio Events
The following audio events can be mapped to wav audio files on your system.    

Abort
Left mouse click on the Mosaic logo or pressing the ESC key.

About Mosaic
From the Help menu, About Windows Mosaic... or the Question Mark in the Tool Bar

Add to Hotlist
The Add to Hotlist icon in the toolbar or open the Hotlist Manager (Navigate, Hotlist 

Manager) and select Edit, Add Current at Selection Point

Load Document
Select the green check next to the URL command or press ENTER.

Navigate Back
Select the left arrow icon from the toolbar or Navigate, Back.

Cancel Location
Select the red X next to the URL command line.

Copy
Select a range of text in a document and the Copy icon from the toolbar or CTRL+C

Document Loaded
Audio notification when Mosaic has received and loaded the document into the document

view window.
Find

Select the Find icon from the toolbar or Edit, Find

Navigate Forward
Select the right arrow icon from the toolbar or Navigate, Forward

History
Select Navigate, History

Home
Select the House icon from the toolbar or Navigate, Home

Image Loaded



Audio notification when Mosaic loads an image into the document view window.

Mail
Select the Mail icon from the toolbar, or use File, Send Email... or enter 

mailto:name@address in the URL command line.

News
Select the News icon from the toolbar, or use File, Newsgroups... or enter 

news:newsgroups into the URL command line.

Open
Select the Open URL icon from the toolbar, or by selecting File, Open URL...
(CTRL+O) or File, Open Local File... (CTRL+L)

Paste
Select the Paste icon from the toolbar or Edit, Paste (CTRL+V).

Preferences
When you select Options, Preferences...

Presentation Mode
Select Options, Presentation Mode (ALT+P)

Print
Select the Print icon from the toolbar or select Edit, Print...

Print Preview
Select the print preview icon from the toolbar or File, Print Preview...

Reload
Select the reload icon from the toolbar or Navigate, Reload

Save
Select the save icon from the toolbar or File, Save As...

Startup
Mosaic greets you when you start the application.



WAV Files:
Click on an event and Mosaic displays the audio file that is mapped to the 
event.    This section also lists the WAV files that are available from the current
 directory.    The current directory appears at the bottom of the WAV file list.

Test
Click to test the highlighted WAV file.



Sound Scheme File:
Displays the entire path to the sound scheme file(.SND).    These files are created
 by Mosaic when you make sound/event associations and they maintain the
 mapping information between the Mosaic events and the audio files.    This file 
is typically found in the C:\Mosaic\audio directory.

Save As
Saves the current collection of events and associated sound files in a SND file.

Load
Loads another specified SND file.



The following options are active when the boxes are checked.

Enable Event Sounds
Enables the Mosaic Audio Events.

Asynchronous
Allows sound events to be interrupted. 

Enable Inline Sound
A new HTML tag not yet approved by the HTML working group.    This tag 
enables the use of WAV files for in-line sound.    Inline sound file can be placed 
in any part of the document or you can define a background sound.    Inline sounds
can also be delayed for X number of seconds.    The tag associated with in-line 
sound is:

<SOUND SRC="*.wav">

Attributes of the sound tag include:

LOOP=infinite    and    DELAY=sec.

e.g., <SOUND SRC="*.wav" LOOP=infinite>        or        <SOUND SRC="*.wav" DELAY=10>



Preference Sheet
Cache

Click on the image for help.



Memory Cache

Number of documents kept in memory:
The number of documents maintained in memory cache during a Mosaic session
The memory cache is volatile.



Memory Cache

Clear Memory Cache
Click on this button to clear the memory cache of all documents and images.



Location:
Defines the entire path to the directory used to store the non-volatile disk cache.

(e.g., c:\Mosaic\Cache\)



Size (KB):
Defines the number of KBs allocated to the disk cache (1M = 1024KB)

The following options are active when the boxes are checked.



Enabled:
Disk cache is enabled.



Fast Image Caching:
Converts cached in-line images into a .bmp format, which increases the
display speed of the in-line image when they are loaded from the disk cache.



Never purge home page:
The home page is always available from the disk cache.



Clear Cache on Exiting Mosaic
Mosaic clears the disk cache when you exit the program.



Check Modification Date From Server:
Ensures Mosaic displays the most current version of a document.    Mosaic 
requests the file size and date stamp from the server and if the file has not
changed, Mosaic loads the file from the disk cache.    If the file has changed,
Mosaic requests the document from the information server.    You can also set
Mosaic to check the documents currentness once per session or every time 
it loads a document.

Click Once Per Session if you want Mosaic to check the time stamp once 
during your current session.

Click Always if you want Mosaic to check the time stamp every time you
go to a page.



Advanced Cache Manager
Click on the image for help.



Hits
The number of times the file has been loaded from the cache.

Size
The size of the file.

File
The actual name of the file.

URL
The address of the file in URL format.

Below the window is statistical data about the contents of the cache.    Displayed is the
total number of items in the disk cache and the amount of disk space being used by 
the cache (KB).    Also displayed is the Cache Hit Percentage that shows the percentage of
times items are accessed from the cache.    This data is displayed in terms of the life of the 
cache and in terms of the current Mosaic session.



Load URL:
Select an item from the cache management item list and click to load the file.

Delete:
Deletes the selected item(s) from the cache.    The cache management item list
supports the standard Shift + Left click to select a range of items and/or 
Ctrl + Left click to select individual items.

Never Purge:
Marks a highlighted item so it will not get deleted if you clear the cache or 
updated if the item changes on the server.    An asterisk (*) next to the Hits field 
appears on these Never Purge items.

Can Purge:
Highlight an item marked Never Purge and click this button to removed it from
the never purge list.    If Check Modification Date From Server is checked, Mosaic
updates the file the next time you visit the web site.

Clear All:
Deletes the contents of the disk cache except for the items marked with an 
asterisk.    



Sort by:
Sort the contents of your disk cache by one of the following methods.

File:
Sorts the disk cache management window by the file type

Server:
Sorts the disk cache by the alphabetical order of the server name.

Size:
Sorts the disk cache by file size.

Hits:
Sorts the disk cache by the number of times the file is pulled from the cache. 
(The first element in the list has the highest hit percentage.)

Mime:
Sorts the disk cache by MIME type.



Cache the following mime types? 
Displays a list of the current MIME types in your viewers section and the 
cache status for each MIME type.    Select a MIME type and click Yes to add 
the file type to your disk cache or select No to delete a file type of file from 
the disk cache.



Close

Saves the current settings and closes the window.



Preference Sheet
Directories

Click on the image for help.



Default Download Directory
Defines the path to the default directory where Mosaic will save all files 
you download from the network.



Global History File
Defines the path and file name of the global history index (.ghi) file.    To clear the 
global history click Clear  from the visited anchor section on the
anchor preference sheet.



News Index File:
Defines the path and file name to the news.lst file.    This file contains the titles to the 

various Newsgroups available from your news server.    This file is created by Mosaic when you 
configure the News preference sheet and select the subscriptions button..    



Preference Sheet
Document

Click on the image for help.

The preferences are active when the boxes are checked.



Inline Images 

Display Inline Images
Enables in-line images to appear within an HTML document.    When blank, in-line
images and background images are not shown.    In-line positions are held by an
 icon and alternate text is displayed if it is available.

3D Borders
Surrounds all in-line images with a three-dimensional border.



Background Color

Opens a color palette where you can select a new color for the default 
background color of the document view window.



Miscellaneous

3D Rules
Displays horizontal rules ( <HR> ) as three-dimensional lines instead of solid 
black line.

Round List Bullets
Displays a 3D bullet at the beginning of each list item in an unordered list 
( <UL> ) or menu list ( <MENU> ).    A dash is displayed if this option is not
selected.

Send Referrer Field
Mosaic will send the URL of the page you came from when you contact a 
server for information.    Referrer allows WWW sites to determine where the
majority of the Web traffic is coming.    The referrer URL is not sent if you do 
not select this option.



Home Page

Autoload
Mosaic automatically loads your defined home page.

The address to your home page is defined by a URL. The home page file is written in
HTML (HyperText Markup Language).    This file can reside on the network or it can be
local file on your system.    The URL address for a local file is defined in this format:

file:///c:/directory/filename.htm

Use Current
Click on this button and Mosaic will automatically save the URL of the present
document as your home page.



Advanced Tags

Use <BODY> Attributes
Display background images using the HTML 3.0 <BODY BACKGROUND =
image.gif> attribute.

Use <META> Tag
Allow Mosaic to be automatically prompted to another page. 

Prompt Before Using <META> Tag
Prompt user before allowing Mosaic to change pages.



Display

Display Text while Loading
Displays the document while it is being downloaded.

Display Images While Loading
Displays in-line images after they are downloaded and while Mosaic is downloading 
other images.

Disable Display While Loading
Forces Mosaic to wait until the document and all images are downloaded before
it is displayed.



Preference Sheet
Fonts

Click on the image for help.



Mosaic Font Groups:
Displays the name of the font groups available to Mosaic. To view the contents
of a group double click on the group name.

Default
The default font group.



New
Click and enter the name of a new font group.    Click the check to create a new
 font group or click the X to cancel and close the window.    
Note:    The initial settings for a new font group reflect the current settings in
the default group.

Remove
Deletes the selected font group

Edit
Changes the name of the font group.

Change
Select a font and click to change the font type, size, or color.



Current Font Group:
Select the font group you want Mosaic to use.

Magnification Units:
The value from 1 to 5 that is used to multiply the size of the font using the 
+ or - key.



Preference Sheet
News

Click on the image for help.



Display Options

There are three ways of displaying news articles.    Select one of the following choices.

Thread View
Display the top level messages without reply messages.

Group View
Display the top level message and the first level of replies.

Tree View
Display the top level and all replies in hierarchical format. (Replies to replies are
represented at different levels of the hierarchy.)



Number of articles to load:
Defines the number of news article headers you want Mosaic to retrieve from the
news server.    One Thousand is the maximum number.



Number of articles to display:
The number of News articles you want Mosaic to display in the document view
window.    Ten is a minimum and One Hundred is a maximum.



NNTP Server:
Enter the name of the machine that provides your news services.    
(e.g., news.ncsa.uiuc.edu

Note:    Many news servers are restricted to certain domains.    Your Internet access
provider should provide you with the name of your local news server.



.sig file
Enter the path to your signature,(.sig), file.    This file is a text file that contains
contact information about you and/or your organization.    This file is also used
when post a message to a newsgroup or mail a message using.



Show Toolbar
Displays an easy to use, dockable toolbar while you are reading news.    To dock
the News toolbar, click on its frame and drag it to any of the four sides of the
Mosaic window or to any position on the screen.



Load All Articles:
When checked Mosaic loads all available news article headers for the newsgroup
you select in Mosaics News interface.    This feature disables the Number of
articles to display: feature.



News Subscriptions
Click on the image for help.



Search:
Enter the name or prefix of a newsgroup. Mosaic comparatively matches your
entry to the available newsgroups in the list, scrolls through the list and displays 
its finding. 



Available:
Displays the names of newsgroups that are available from your news server.
The available newsgroup list supports the standard Shift + Left click to select
a range of items and/or Ctrl + Left click to select individual items.



Subscribed:
Displays a list of the newsgroups which you have subscribed..



Subscribe:
Adds the selected newsgroup(s) from the available field to the subscribed field.
Select a newsgroup from the available list, click subscribe to move the
newsgroup to your subscribed list.

Unsubscribe:
Deletes the selected newsgroup(s) from the subscribed list and moves it back to
the Available list.    Select a newsgroup in the subscribed list, click on 
unsubscribe to remove it from your subscribed list.



Update:
Click update to query the news server for the latest list of available newsgroups.



Select All:
Selects every entry in either the Available field or the Subscribed field
depending on the location of your cursor.

Unselect All:
Deselects the entries that were selected.



Preference Sheet
Printing

Click on the image for help.



Margins

Allows you to define print margins in terms of inches.    The default setting is 0.50
or ½ inch.    Enter 0 to disable print margins.

Left:
Defines the size of the left margin.

Right:
Defines the size of the right margin.

Top:
Defines the size of the top margin.

Bottom:
Defines the size of the bottom margin.



Print Document Title
Prints the title of the document as defined in the <TITLE> tag.    The title appears
at the top and centered on the page.

        On First Page
The title is only printed on the first page of the document.

        On Every Page
The title is printed on every page of the document.



Print Document Location
Prints the document location in the lower left hand corner of the printed 
document. 



Print Page Numbers
Prints the page numbers in lower right hand corner of the document.    The page
numbers are displayed in terms of the present page with respect to the total 
number of pages.    (e.g., 1    of    5)



Print Date
Prints the date the document was printed.    The date stamp appears in the lower
right hand corner of the document and to the left of the page number.



Print Time
Prints the time the document was printed.    The time stamp appears in the lower
right hand corner next to the date stamp and to the left of the page number.



Preference Sheet
Proxy

Click on the image for help.

Firewalls are employed by many organizations to protect their local area networks (LAN) from 
intrusion and to prevent unauthorized employees from leaving the LAN.    Unfortunately, 
firewalls also prevent NCSA Mosaic from directly retrieving documents from the Internet 
without the use of a proxy gateway.

A proxy gateway allows Mosaic to request information from the Internet through the system 
running proxy gateway software.    The proxy gateway (or proxy server) receives a request in the 
form of a URL from a Mosaic client running inside the firewall and makes the request to the 
Internet.    It then and sends the information back to the requesting Mosaic session behind the 
firewall. Thus the actual network request is handled exclusively by the proxy server.    Typically 
the machine running the proxy gateway software is the only machine directly connected to the 
Internet. After you configure Mosaic to use a firewall, you should feel directly connected to the 
Internet.

Not all organizations use firewalls and/or proxy gateways.    Contact your local system 
administrator to determine if you need to use one to gain access to the Internet.    Your system 
administrator will also be able to tell the name of the machine running the proxy gateway 



software.



HTTP Proxy Server:
FTP Proxy Server:
WAIS Proxy Server:
Gopher Proxy Server:

Enter the name and the port number of the machine that is providing the proxy services.    
Typically one machine provides proxy services for all of the protocols.    If you do not need or do
not have access to one of the above protocols, leave the field blank.

For example:

HTTP Proxy Server: proxy.ncsa.uiuc.edu:8080
FTP Proxy Server: proxy.ncsa.uiuc.edu:8080
WAIS Proxy Server:
Gopher Proxy Server: proxy.ncsa.uiuc.edu:8080



Machine/Domain List:
Displays a list of network domains that are affected by proxy services.    Users
behind firewalls typically define    proxy all others.    However, if your
organization runs a WWW server behind a firewall and you access information
from that server, you would configure the local domain for no proxy.
For example,

no proxy ncsa.uiuc.edu
proxy all others

NOTE:    You can switch the proxy/no proxy state of a machine or domain by double
clicking on its name in the Machine/Domain List.



Add
Enter the machine name or the domain name of a system you want to add to the
Machine/Domain List.

Remove
Select an entry in the Machine/Domain List and click remove to remove it from 
the list.

Proxy
Associates the proxy status with the selected domain.    Select a domain name from
the Machine/Domain List and then click Proxy to add use the proxy server to
access information from this site.

No Proxy
Associates the no proxy status with the selected domain.    Select a domain name
from the Machine/Domain List and click No Proxy to bypass the proxy server and
access information directly from the site.

NOTE:    You can switch the proxy/no proxy state of a machine or domain by double
clicking on its name in the Machine/Domain List.



Preference Sheet
Services

Click on the image for help.



Mail

Name:
Enter your name.

E-mail Address:
Enter your email address

SMTP:
Enter the name of your Simple Mail Transfer Protocol (SMTP) server.    Contact 
your system administrator or Internet access provider for the name of your 
mail server.



FTP

Use Extended FTP
Associates meaningful icons to directories and file-types on an FTP server.
Mosaic also displays the file size information.    When blank, Mosaic displays
just the names of the files and directories.

External FTP Messages
Mosaic displays the messages generated by an FTP server in a separate window.

Inline FTP Messages
Mosaic displays the messages generated by an FTP server in-line with the file and
 directory data.    The messages are displayed at the top of each page.



tn3270

Enter the path of your TN3270 Telnet application.    For example,
c:\directory\tn3270.exe

Click Browse, to open a standard Microsoft Windows browse window.    Find your
telnet application, click OK, and Mosaic will fill in the above path information.

After youve defined a tn3270 application, you can use URLs in the following
format:

tn3270://johndoe@machine.name.com

Mosaic will launch the tn3270 program and query the defined machine for a login.
You can create a hotlist of easy access to remote machines.      ;^)



Network

Timeout:
Enter the amount of time you are willing to wait for a Web site to make a 
connection with Mosaic.    Time-out is defined in seconds and is set to 60 seconds 
by default.



Telnet

Enter the path of your Telnet application.    For example,
c:\directory\telnet.exe.

Click Browse, to open a standard Microsoft Windows browse window.    Find your
Telnet application, click OK, and Mosaic will fill in the above path information.

Telnet applications use either a colon or a space to distinguish a specific port number.
Select one of the options based on applications your needs.

Host:port:
When selected, Mosaic uses a colon to distinguish the port number as specified
in the document URL field.

Host port:
When selected, Mosaic uses a space when you specify a port number.

After youve defined a Telnet application, you can use URLs in the following format:

telnet://johndoe@machine.name.com

Mosaic will launch the tn3270 program and query the defined machine for a login.
You can create a hotlist of easy access to remote machines.      ;^)



TCP/IP CCI Server

Enabled
Enables the TCP/IP CCI server.    Enabled allows programs to use the
 TCP/IP CCI command set to remotely control Mosaic. 

The same TCP/IP CCI technology is used for Mosaics Collaborate... feature, to 
demonstrate the power of this technology.    However, you should NOT enable the
TCP/IP CCI Server to use collaborate. 

NOTE:    The typical Mosaic user will keep this feature disabled.

Port:
Defines the port where the Mosaic TCP/IP CCI Server will send and receive data.

Chat Alias:
Enter a name you will use when you are collaborating.    If no name is entered, 
Mosaic will use the user ID in your email address.    For example:

johndoe@some.company.com

The name that appears in a collaborative session will be:
johndoe    



Preference Sheet
Tables

Click on the image for help.



3D Tables:
Displays table borders with a 3D frame affect.

Recessed Tables:
Inverts the 3D frame border to give the table a recessed appearance. 

Display Empty Cell:
Displays each empty cell instead of making them appear as part of the frame.



Red: Green: Blue:
Displays the current RGB color value of the table frame.

Change:
Opens a color palette where you can select a new color for the table frame.



Preference Sheet
Viewers

Click on the image for help.

NCSA Mosaic for Microsoft Windows can use other applications to display file types such as, 
Microsoft Word, Postscript,    MPEG movies, Quicktime movie, etc.      These applications can be 
commercial software, Shareware, Freeware or copyright software.    We refer to these 
applications as external viewers.    In general, if an application can accept command line inputs, 
Mosaic can use it as an external viewer.    When Mosaic downloads a file that it cannot display, 
Mosaic can pass the file to an external viewer and this application will display the file to you. 
For example, if you have Microsoft Word, you can configure Mosaic to pass all files that have 
the MIME (Multipurpose Internet Mail Extension) type of    application/msword or files extended
with .doc to your Microsoft Word application.

For more information about MIME types, available viewers and configuring Mosaic to use 
specific viewers, select on-line Resources from the Help menu and click on the Viewers link.



Associate MIME Type of:
Displays the MIME types and subtypes.    Click on the arrow button to view the
current list of MIME types.    

CAUTION:    If you edit information in this field, it will change your view configuration.



Description of MIME Type (Optional):
A description of the MIME type displayed in the above field.



With This/These Extensions:
Enter the file extension(s) associated with the MIME type displayed in
the Associate MIME Type of: field.



To this Application:
Enter the path and the executable name of the external viewer. Make certain the
application software is capable of handling the MIME type. Use the Browse...
function to create this association.

Browse...
Opens the standard Windows tree format dialog box for viewing your
directories and files. Find the appropriate application software and click OK.
Mosaic then fills in the appropriate information in the To this Application: field.



Specify internal to display image/??? Or audio/?wav objects within Mosaic

Mosaic can internally handle the following MIME types if you define the To This Application: 
field as internal for each MIME type. 

audio/wav
audio/x-wav

image/gif
image/jpeg
image/bmp



Add
Click Add to add a new MIME type to the MIME type list.

Remove
Click to delete the MIME type that is displayed and all associated information from your
MIME type list.



Preference Sheet
Window

Click on the image for help.



Toolbars at Startup

Show Toolbar
When checked, the toolbar appears on startup.

Show Location Bar
When checked, the location bar appears on startup.

Show Status Bar
When checked, the status bar appears at the bottom of the Mosaic window
on startup.



Date/Time

Mosaic displays the Day/Date/Time information in the progress indicator section of the Status 
bar when Mosaic is not loading files to the document view window.

Display Day
Display the current day:    Mon, Tue, Wed, Thu, Fri, Sat, Sun

Display Date
Displays the current date:    10/11/95

Display Time
Displays the current time:    9:58:44 pm



Initial Window Placement

Defines the X & Y coordinate of the top left corner of the window and the width and height 
attributes of the Mosaic window.    These settings define the size and location of the Mosaic 
window when you start the program.

Use Current Window Position

Click and Mosaic saves the current window position and size as the default settings.



OK
Saves and applies the changes to current session and closes the Preferences 
window. 



Cancel
Aborts changes and closes the window.



Apply
Saves and applies the changes to current session and leaves the Preferences 
window open.



Help
Opens the Mosaic Help file.    This file....    ;^)



Advanced Hotlists Manager...
Click on the image for help.



Advanced Hotlists Manager...
File Menu

Click on the image for help.



New Ctrl + N
Creates a new hotlist .hot file.    This function prompts you for the name of the new 
.hot file and the name of the first folder within the file.    If you do not name the 
first folder, Mosaic uses the name of the file as the default. 



Save As... Ctrl + A
Saves The current hotlist file as a .hot or .htm file.    Select Save As, select a 
directory , file name and file type and click OK.



Import HTML File...Ctrl + I
Import HTML File... opens the standard Windows open dialog box to allows you 
to select an    HTML file for importing; it adds a    folder to the current hotlist file, 
copies the appropriate links to the new folder and displays the HTML file in the 
document view window.    This feature allows you to add or create new Mosaic 
hotlist files (.hot) using other hotlist and bookmark files saved in HTML format. 
This function will not alter the original HTML file.



Import Anchors From Current Document
Copies the anchor names and URLs of    the current document to a new folder in 
the present hotlist.    The title of    the new folder is the title of the current document.    



Export to HTML File... Ctrl + E
Exports the current hotlist(.hot) file into an HTML(.htm) file.



Close Ctrl + X
Closes the Advanced Hotlist Manger window.



Advanced Hotlists Manager...
Edit Menu

Click on the image for help.



Delete Del
Click on a folder or an item and select delete to delete the it from the current hotlist.



Insert New Item...
Adds a new item to a hotlist.    Enter a document title and location (URL) in the 
dialog box and click OK.    The new item is added above the position of the cursor 
if it is pointing at another hotlist item and added to the bottom of a folder if the 
cursor is pointing to a hotlist folder.



Insert New Folder...
Defines a new hotlist folder.    The new folder is inserted above the current 
selection point.



Advanced Hotlists Manager...
Options Menu

Click on the image for help.



Always on Top
Makes the Advanced Hotlist Mangers window remain on top.



Open on Startup
Open the Advanced Hotlist Manager when you start a Mosaic session.



On Menu Bar
Displays the top level hotlist folders in the Mosaic menu bar.



One Root
Displays the hotlist folders under one menu item in the Mosaic menu bar.



Change Font...
Opens a font dialog box where you can change the Advanced Hotlist Managers 
font, style, and font size.



AutoSurf
The AutoSurf feature is used to download documents from your favorite sites to 
your disk cache for viewing at a later time.    For example, you could send Mosaic 
to a site, download files relevant to a particular to your favorite hotlist and save 
these file for viewing off line.



Update Time Stamps
Updates the time stamps of each item in a folder or the entire hotlist to the present days date and 
time.    



Whats New Since...
This feature contains everything the Whats New feature offers except it allow 
you to define the date to begin the search.    Select the appropriate date and watch it 
update your hotlist.    



Remove Items That Dont Exist
Removes all hotlist items marked with a  from your hotlist.    Items are marked 
with the red X when Mosaic cant find the file during a Whats New update.    
These files no longer exist on the server.



 Open...
Opens a new hotlist .hot file using the standard File Manager open dialog box.    
Locate the appropriate directory and select a file; click OK.    The Advanced Hotlist 
Manager is capable of reading hotlists from    .hot files and from the mosaic.ini file. 



 Save
Saves the current hotlist file to its current filename.



 Properties...

Edits the properties of a hotlist item.    These items include folder names and folder 
items.    Select a folder and Properties to edit its title or select a hotlist item to edit 
its title, URL, date and time stamp.



 Alphabetize 
Alphabetize the contents of a single folder or all folders.



 Whats New?

Whats New feature checks a hotlist folder or an entire hotlist to ensure the items 
are current.    The Whats New feature checks the date of the items listed in your 
hotlist and displays its findings next to each item in the hotlist.      If the date of 
your current link differs from the file on the server, the Advanced Hotlist Manager 
marks the file as     If the file has moved and no longer exists, Mosaic marks it 

with .    If the Web server or Mosaic times out during the date request, it marks 
the item with .      If the document hasnt change, Mosaic marks the file with a 
document icon. 



 Open All Folders
Displays the contents of all hotlist folders.



 Close All Folders 
Closes all hotlist folders.    Only top level folders will be displayed.



 Find Hotlist Item
Opens the Advanced Hotlist Managers Find Hotlist Item dialog box.    Enter the 
word you are searching for in Find What: field and select Find Next to begin 
the search.    



 Add Current to Folder
If a folder is not selected, Mosaic adds the current page to the bottom of the folder 
defined in the Add to: field.    If a folder is selected, Mosaic adds the link to the 
bottom of the selected folder.    If a hotlist item is selected, Mosaic adds the link 
above the selected hotlist item.



 Help
Opens Mosaic Help



Hotlist:
Displays the directory path and file name of the current hotlist.

Add to:
Displays the name of the folder that is linked to the Add to Hotlist Folder button
on the toolbar.    When click the  button, a link to the current page is added to 
bottom of the folder defined in this field.



Hotlist Display Area
Displays the hotlist folders and hotlist items using a hierarchical tree structure 
similar to the Windows File Manager.    You can move items from one folder to 
another or arrange the items in a folder by dragging and dropping the folder or 
item to the desired location.

Data Display Area
Displays information about the item that is highlighted in the hotlist display area.
It displays the name of the current folder or the address (URL) of the hotlist item
the cursor is pointing.    This area also displays a count of the total number of lists 
and sublists defined in the current hotlist file.



Advance Hotlist Manager Search Menu

Find...
Opens a Find Hotlist Item dialog box. Enter the characters, word(s), or phrase you 
want to search for in the current hotlist.    Click Find Next to begin search.    

Find Next F3

Initiates a search with the current entry in the Find dialog box.    Find Next also has 
a shortcut key, hit F3 to find the next instance of the current character string.



Advanced Hotlist Manager Help Menu

Contents
Opens the first page of the NCSA Mosaic help pages.    NCSA Mosaic Help is 
context sensitive, just point and click on the item of interest.

Search on Help
Opens a search window relative to Mosaic Help

How To Use Help
Opens the standard Windows Help tutorial.



Mosaic AutoSurf...
Click on the image for help.

Mosaic AutoSurf was designed to allow users to easily download a number of documents linked 
to a specific HTML document and save the documents in the disk cache.    The disk cache must 
be enabled to use AutoSurf.    This feature is useful to Mosaic users who are limited by a slow 
connection and/or who pay per hour network access fees.    Using Autosurf, you can cut your on-
line time down significantly.    For example, if you initiate AutoSurf from the NCSA Whats New 
page, you could download all the first level documents while your eating dinner and view them 
off-line.    Mosaic's built-in stand-alone option, mosaic.exe -s, is an ideal way to view local files.



General

Maximum Depth:
Defines how deep AutoSurf will go before it moves to the next link(Depth First 
Search) or the max. depth it travels during its total search(Breadth First 
Search)

Maximum Number of Documents:
A user defined number from 1 - 1000.    We ask that you only download a useful 
number of documents.    If this feature is abused, we will have to impose smaller 
maximum number.    Please be responsible and only download a reasonable 
number of documents that will be useful.

Follow All Links
Follow all links local and remote.

Only Follow Links On Initial Server
Restricts the AutoSurf to the initial server.

Dont Follow Links on Initial Server
AutoSurf wont follow links on the initial server, only follow links on remote servers.

Load Inline Images
When enabled, Mosaic downloads the in-line images associated with each 
document AutoSurf downloads.

 
Display Documents(faster when off)

Displays the documents as they are being downloaded from the network.    For best
AutoSurf performance, disable this feature and view the documents from the 
cache.



Output Log

Mosaic also maintains a log with detailed information about the results of a search. This log file 
contains the information about the Starting Document, the Maximum Depth, the Surf Algorithm, 
A list of the document addresses, the Number of Documents Loaded, the Number of Errors, Total
Elapsed Time, and Total Number of Bytes Downloaded.

Mosaic reports this information using the following methods:

None
AutoSurf will not keep a record of the search.

HTML Format
AutoSurf writes the data into an HTML formatted document.

Text Format
AutoSurf writes the data into a simple ASCII file.

Log File:
Defines the directory path and file name to the log file.



Surf Algorithm

Breadth First    vs. Depth First

The surf method used to download the documents are the breadth first search or depth first 
search algorithms.    Working under the assumption the first document downloaded represents 
level 0, the behavior of these search algorithms is as follows.

Breadth First -    Using a breadth first search, depth = 2 and a maximum documents = 100, 
Mosaic downloads the first page, then it goes to the first link and downloads that page.    
Returning to the first page AutoSurf goes to the second link downloads that page.    After all links
are downloaded on the first page, Autosurf goes to the first document on the second level and 
begins to download the documents linked to that page in the same.    Mosaic continues to 
download documents until all of the two level deep documents have been downloaded or the 
maximum number of documents has been met.

Depth First    -    Using a depth first search, depth = 2 and maximum documents = 100, Mosaic 
downloads the first document and goes to the first link and downloads that page.    It then goes to 
the first link on the first level document and downloads that document.    Next it goes to the 
second link on the first level and downloads that document.    AutoSurf continues until all links 
are exhausted and then proceeds to the second link on the first document and downloads the 
documents associated with that link.    AutoSurf continues until it reaches the end of the search or
the maximum number of documents is achieved. 



Start
Start AutoSurf.    Kick back and relax.    ;^)

Cancel
Abort AutoSurf.



Mosaic Command Line Options

Mosaic accepts command line parameters that define certain functionalitys.    To change the 
command line of the Mosaic program icon, single click on the Mosaic icon and select Properties 
from the Program Managers File menu.    The Program Manager opens a dialog box that defines 
the properties of the program.      Place your cursor at the end of the Command line:  and enter 
the switch or switches you want to start Mosaic under.    A switch is a parameter passed to a 
program in the form of a dash (-) followed by a letter or a string of letters. There is always a 
space between the executable name, the switch and any switch parameters.    For example: 

Command Line: c:\mosaic\mosaic.exe -i c:\mosaic\mosaic.ini

Note:    Multiple parameters can be passed on the command line.

-i -cciserverlimit N
-s -collablimit N
-k -collabdroplimit N
-pen -hostcollab
-nosplash -port
-presentation -nodde
-notcpip

-i

The -i switch allows you to invoke Mosaic using the initialization file defined in the path.    

e.g., c:\mosaic\mosaic.exe -i c:\mosaic\mosaic.ini

The name of the initialization file is arbitrary and if you have a computer with multiple 
users, you can create a unique Mosaic icon for each user.    Each user would have a unique 
Mosaic initialization file and they could create a custom environment.    For example, 
change the properties    fields to reflect similar information

Description: Terrys Mosaic
Command Line:    c:\mosaic\mosaic.exe -i c:\mosaic\terry.ini



-s 

The -s switch tells Mosaic to start in Stand-Alone Mode.    Stand-alone mode allows a user 
to view local documents while not connected to the network.    If you try to access a 
networked file, Mosaic will display an error message reminding you that you are not 
logged in.

e.g., c:\mosaic\mosaic.exe -s



-k

The -k switch invokes Mosaic in Kiosk Mode.    Kiosk Mode is a restricted version that
prevents anyone from saving data to the local machine.    This mode is ideal for running 
Mosaic as a public kiosk.    By default , kiosk will not allow the user to exit from within 
Mosaic.    The exit command is removed from the File menu.    If you want to include the 
exit command in the file menu you must also pass the -exit parameter in the command 
line.

e.g., c:\mosaic\mosaic.exe -k (Kiosk w/o an exit option in the File menu.)

e.g.,  c:\mosaic\mosaic.exe -k -exit (Kisok with an exit option in the File menu.)



-pen

Enables middle mouse button control over Mosaic.    Depressing the middle mouse button and 
moving it in one of the following patterns produces the following result.

e.g., C:\mosaic\mosaic.exe -pen

Moving the Mouse Produces

Left BACK
Right Forward
Up Page Up
Down Page Down
Backward C Preferences
L Home
Upside-down L Hotlist Manager



-nosplash

Disables the splash screen from appearing.

e.g., c:\mosaic\mosaic.exe -nosplash



-presentation

Opens Mosaic in Presentation Mode.

e.g., c:\mosaic\mosaic.exe -presentation



-hostcollab

Invokes the Mosaic client with the collaborative server.    If you do not specify a port number of 
the host it defaults to port 2112.    If you want to specify a port number, must use the -port switch 
in conjunction with -hostcollab command line switch.

e.g., c:\mosaic\mosaic.exe -hostcollab
or

e.g., c:\mosaic\mosaic.exe -hostcollab -port 2001



-port

Defines the port number where the collaborative server will send and receive data.

e.g., c:\mosaic\mosaic.exe -port 2001



-cciserverlimit N

Limits the number of connections the TCP/IP CCI server will accept. .    N is equivalent to the 
number of connections.

e.g., c:\mosaic\mosaic.exe -cciserverlimit 5



-collablimit N

Limits the number of clients during a collaborative session.    N is equivalent to the number of 
collaborators

e.g., c:\mosaic\mosaic.exe -collablimit 10



-collabdroplimit N

Limits the size of the files that can be dragged and dropped on the collaborative session 
window. .    N is equivalent to the maximum file size accepted by the collaboration window.    
The size of the file is measured in Bytes.



-nodde
Disables the DDE communications between Mosaic and external applications.



-notcpip
Disables the TCP/IP communications between Mosaic and external applications.



NCSA Mosaic Copyright Notice

NCSA Mosaic Software
National Center for Supercomputing Applications
University of Illinois at Urbana-Champaign 

NCSA Mosaic software [both binary and source (if released)] (hereafter, Software) is 
copyrighted by The Board of Trustees of the University of Illinois (UI), and ownership 
remains with the UI. 

The UI grants you (hereafter, Licensee) a license to use the Software for academic, research and 
internal business purposes only, without a fee. Licensee may distribute the binary and source 
code (if released) to third parties provided that the copyright notice and this statement 
appears on all copies and that no charge is associated with such copies.    

Licensee may make derivative works. However, if Licensee distributes any derivative work 
based on or derived from the Software, then Licensee will

1. notify NCSA regarding its distribution of the derivative work, and 
2. clearly notify users that such derivative work is a modified version and not the original 

NCSA Mosaic distributed by the UI. 

Any Licensee wishing to make commercial use of the Software should contact the UI, c/o 
NCSA, to negotiate an appropriate license for such commercial use. Commercial use 
includes 

1. integration of all or part of the source code into a product for sale or license by or on behalf 
of Licensee to third parties, or 

2. distribution of the binary code or source code to third parties that need it to utilize a 
commercial product sold or licensed by or on behalf of Licensee. 

UI MAKES NO REPRESENTATIONS ABOUT THE SUITABILITY OF THIS SOFTWARE 
FOR ANY PURPOSE. IT IS PROVIDED "AS IS" WITHOUT EXPRESS OR IMPLIED 
WARRANTY. THE UI SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY 
THE USERS OF THIS SOFTWARE. 

By using or copying this Software, Licensee agrees to abide by the copyright law and all other 
applicable laws of the U.S. including, but not limited to, export control laws, and the terms of 
this license. UI shall have the right to terminate this license immediately by written notice upon 
Licensee's breach of, or non-compliance with, any of its terms. Licensee may be held legally 
responsible for any copyright infringement that is caused or encouraged by Licensee's failure to 
abide by the terms of this license. 



Glossary of Terms
This file is a list of terms, acronyms and different file types you run across while exploring the 
Internet.

Anchor 
a synonym for hyperlink 

.aiff 
an audio file format (Audio IFF)

Archie 
a method of searching for files on anonymous FTP servers 

.au 
a sound file format 

Browser 
a World Wide Web client. An information retrieval tool. 

CERN 
The European Laboratory for Particle Physics. The originators of the HTTP and 
HTML concepts 

Client 
The software that allows users the ability to retrieve information from the Internet 
and World Wide Web. NCSA Mosaic is an example of client software. 

External Viewer 
a program used by Mosaic when Mosaic cannot handle a particular file type 
internally.    For example, .ps or postscript files. When Mosaic retrieves a .ps file it 
will pass the file to a postscript viewer and the viewer will display the file to the 
user 

FAQ 
A file that contains Frequently Asked Questions and answers 

FTP 
File Transfer Protocol, a method of transferring files to and from remote 
computers 

GIF 
Graphics Interchange Format, an image file format 

Gopher 



a text based distributed information system developed at the University of 
Minnesota 

History List 
A list of Document Titles and URLs Mosaic keeps in memory that represents the 
visited URLs during a given Mosaic session 

Home Page 
The top level document of a organization or a document that a user frequently 
visits.    By default Mosaic points to the Mosaic home page, however you can 
define anyone's home page as your home page.    This document is usually 
displayed when you start a Mosaic session. 

Hotlist 
a user defined list of World Wide Web documents 

HTML 
Hypertext Markup Language.    A set of tags that define the syntax of hypermedia 
documents.    These documents are characterized by the .HTML or .htm file 
extension. For example: homepage.html or homepage.htm 

HTTP 
Hypertext Transport Protocol, the protocol used to communicate with World 
Wide Web servers 

Hyperlink 
A link in a hypermedia document to: other text, images, movies, audio files, 
applications, etc....    The links documents are usually represented by a highlighted 
word or image.    The user also has the option to underline these hyperlinks. 

Hypermedia 
Richly formatted documents containing a variety of information types, such as 
textual, image, movie, and audio. These information types are easily found 
through hyperlinks. 

In-line image 
a graphic image that is displayed in-line with text in an HTML document. 

Internet 
An International computer network of computer networks that connect 
government, academic and business institutions. 

JPEG 
Joint Photographic Expert Group, a method of storing an image in digital format 

MIME 



Multiple Internet Mail Extensions, The MIME type defines the type of file.    For
 example, plain text, HTML files, image files, movie files, audio files, are specific 
file types that have a unique MIME type

MPEG 
Moving Pictures Experts Group, a method of storing movie files in digital format 

NCSA 
The National Center for Supercomputing Applications. NCSA is located at the 
University of Illinois campus in Urbana-Champaign, Illinois.    The NCSA 
Software Development Group created NCSA Mosaic and released version 1.0 on 
November 12, 1994.

PostScript 
A page description language developed by Adobe Systems 

Protocol 
A planned method of exchanging data.

QuickTime 
A method of storing movie and audio files in a digital format. Developed by 
Apple Computer 

RFC 
The Internet Request For Comments (or RFC) documents are the agreed upon 
standards that define the protocols and policies of Internet data exchange. 

Server 
A computer that serves information and software to the Internet community 

SGML 
Standard Generalized Markup Language, is an International standard, a encoding 
scheme for creating textual information. HTML is a subset of SGML 

TCP/IP 
Transmission Control Protocol/Internet Protocol, a set of rules that establish the 
method with which data is transmitted over the Internet between two computers. 

TIFF 
Tag Image File Format, a file format used storing image files 

URI 
(Universal Resource Identifier)    - A method of labeling objects.    URI doesnt 
imply anything about the properties of an object such as its name and/or address. 
URLs, URNs and URCs represent the different forms of a URI.    



URL 
(Uniform Resource Locator) - The URL is a method of addressing an object and    
follow a standard syntax.    A URL contains the protocol being used to access an 
object, the name of the machine that houses object, the directory path to the object 
and the name of the object.    For example, the URL to the NCSA Mosaic for 
Microsoft Windows Home Page is:

http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/index.html

URN 
(Uniform Resource Name) - The next generation of document addresses will be 
maintained by a URN server.      URN servers will maintain the current URL to an 
object and users will refer to object by name. 

URC 
(Uniform Resource Characteristics)    -      The purpose of a URC is to provide 
structure for the representation of URIs and their associated meta-information.    
URCs make a binding between the URN of a resource and its URL.

Veronica 
Software that searches for filenames on Gopher servers 

WAIS 
Wide Area Information Server, a database 

WAV
Audio files native to the Microsoft Windows environment.    These audio files are 
recognized by the .wav extension.

World Wide Web = WWW = W3 = The Web 
A distributed Hypertext-based information system conceived at CERN to provide 
its user community an easy way to access global information 

XBM 
X bit map, a simple image format. XBMs appear as black and white inline 
images.






